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Short description of the system

With Maintenance Master you can keep track of shimponents and jobs that needs to be
addressed. You can also print reports about jadishidve been finished or needs to be
addressed in the near future. For data that hgvieagion date, it is possible to set up email
notification on the office version, so you can gernings about data that are about to expire
or that have already expired. You can also getvanview of expired data in the ship version
by searching for expired jobs or viewing it in poe.

This document describe the features of v5.7 optiogram.

Overview of the main window:

E%: Maintenance Master - v4.5
File Show Edit  About

|:] Feports ,j Fiunning hour mainlist @ Expired jobs

Components =) Specifications . '=)) Jobs =) Spare parts =) History

112 Certificate
130 Consumables

33 Rotating cranes with crane pillars

403 Steering gear, plants and columns, telematar systems

404 Side thrusters Iake: Cerlificate
411 Radar plants

413 Gyro plants, autopilots, compasses
417 Mizc Mautical Equipment Mizc. info:

422 Lifeboat radio transmitters, smergency radio i The 112 component iz a special component in thiz program. *'ou can add additional data to
424 WHF and LIHF telephanes jobs that are created under this component.
425 Calling syst., command telephones, walkietalkies E

427 Light and signal equipment [lanterns, whistles]

431 Anchors with chains and equipment

432 Windlass with chain stoppers and rollers
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441 Machine tools, cutting and welding equipment

444 Cleaning equipment, garbage chutes w
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From the main window, you can add, edit and defeten and sub components (on the left
hand side of the window), edit jobs, specificatisysare parts and look at jobs that have been
signed out (history). You can also look at expiias (search), reports and edit the running
hour main list.



Adding and updating components

The program lets you add, edit and delete mainsabccomponents (left hand side in the
main window).

This is how to add a main component and then asatponent:

To add a main component, click “Add main componértin the menu that pops up when
you click the add button under the component list.

Compaonents
+ 112 Certificate ”
#1390 Conzurnables
+- . 331 Rotating cranes with crane pillars
+- . 403 Steering gear, plants and columnz, telemaotor spstems
+- 404 Side thrusters
+- . 411 Radar plants
] At Cones slowbe subasilate COMpAaEEs
| Add main component | ent
add sub component ithers, emergency radio 3
o Add ] Edit # | Delete

Enter the number and name for the component:

# Add component

Component number: |EEIEI

Component name: |Ehemicals

Cancel Add component

To add a sub component to the newly added main coem, select “Add sub component”
from the menu that pops up on the add button.



Components

A8 Sanitary supply zestems ~
A82 Sanitary discharge sestems, drainage sest. for accommodation
584 Diinking water systems and coolers

GO0 Chernicals

B0 Diesel engines
B34 Controllable pitch propeller plants with nozzles

L7 b sic codiinbioe ansme with thrust bearings, couplings
Add main component

a -

| Add sub component |

] Add ] Edit #| Delete

In the add component window, enter the sub compamember and name:

4 Add component

Component number: |EEIEI.EI1

Compaonent name; |Ehemical tamkz

Cancel Add component

Figure below shows how it looks for the main comgratrand sub component that we added
above:

Compaonents

+- oy 581 Sanitary supply systenns A
b BB Sanitary discharge spstems, drainage syst for accommodation
b 584 Drinking water systemns and coolers
B00 Chermicals
B E00.01 Chemical tanks
BN Diesel engines
634 Controllable pitch propeller plants with nozzles
637 Main reduction gears with thruzst bearingz, couplings
E41 Main Boilers

& Add \Z] Edit # | Delete

Note: You can create sub components of sub compeasnwell. For example if you create a
sub component 600.01.02 it will end up under th@®&D sub component.

Note also that you can add, edit and delete comysrieom several places in the program.
From the buttons as mentioned above, or from tiferéint menus. The top menu let you add



main components (shortcut Ctrl + M) and sub comptséshortcut Ctrl + J) as shown in the
figure below:

£%: Maintenance Master - ¥5.0

File Show | Edit | Ahout

|_-.‘|F|e

Mews main component Chrl+M
Mew sub component kel
Mew unscheduled event

ECi
Mew suppliers Chrl+A

Mew element in mainlist For running hours Ckrl4+H

User admin and rights. .
b BIZUTCH Read With valves

rm

By right clicking on the component list, you gethenu that let you select add, edit and delete
components, in addition to a couple of other ogion

Add main component

Add sub component

Edit component

Delete component

Add unscheduled event

Cuplicate component tree

Import SFI components

Tree - = Expand all

Tree - = Collapse all

The expand and collapse options above are for ekpguand collapsing the content of the
current tree item. So if you do the expand on ta@momponent, all the sub components will
be expanded in the tree so you can see all the @moemps listed under the main component
without clicking on each plus sign to open each@uibponent. Collapse do the opposite (un
expand).

Duplicate component tree:

To duplicate (copy a component tree). Right clitckhe component tree:



Cornporemts I_)) Specificatic

+

b 112 Cetificates
+- 581 Sanitare supply systerns Add main component
DR C02 M ain Engine 1

b4 B02.00 Col. head with valves :

§24 602.02 Clinder liner s 1 eyt

#=4 B0Z2.03 Pistan Delete component

##4 £02.09 Turbo charger Add unscheduled event

+-p BB2 AuxEng PS I
Duplicake component kree

&dd sub component

Tree - = Expand all
Tree -= Callapse all

When selecting the duplicate component tree opttanfollowing windows will pop up:

Duplicate component tree §|

Create new maih companent;

Main component number: |5|:|3

Main companent name: |Main Engine 2

Additional options:

[ Copy spesifications [ Copy jobz [ Copy zpare parts

Create new subcomponents:

Subcaompanent number Subcomponent narme
G301 Cyl. head with valves
0302 Cylinder liner
g03.03 Pistan
B02.09 Turbo charger

Cancel Add components

A new main component will be suggested based @vaitable component number. In this
window you can copy parts of the original tree lbothe tree structure.

In addition you can copy all components specif@adi jobs and spare parts. If the component
that is copied have running hours attached tb&,components running hours from the
running hour main list will also be copied and eltiad to the new components.



Import SFI components

You can use the import function to build your comguot tree from the SFI component list. Select the
main and sub components that you would like toasighown below.

Import 5F| components

= 1 Ship general -
+- ' 10 Specification, estimating, drawing, instruction, courses
=k 171 Inzurance, fees, certificates, representation
+- b 111 General insurance
+-I" b 112 Classification & statutory fees & certificates
=W k' 113 Building advance interest. dizcount, finance costs
[ % 112.0010 Interest expenses
V¥ 424 113.005 Discourt rate losses
[T #24 113.010 Exchange rate losses
[T #4 113.015 Financial costs
I b/ 114 Cancellation expenses
I b/ 115 Penalties
+-I" |/ 116 Brokers' commissions
+-[7 b 117 Representation, travels, conferences
+€- | 118 Launching & delivery representation
by 12 Quality azsurance, general work, models
b 13 Provizional nigging
b 14'Work on waws, launching, docking
b 15 Quality control, measurements, tests, tials
b 1B Guarantee/mending work,
b 17 Ship repair, special services
19 Conzumption articles
2 Hull
/3 Equiprnent for carngo b

Cancel Add components

EFE =565 -R-EF
r

] [+

When you click on the "add components" button. Etmponents will be saved and added to the
components list in the main window.

Running hour main list

Some components use running hours (for examplenerngzirts) instead of expiration date. To
enable running hours for a component, add it tawhaing hour list:



Add running hour mainlist element

Filter components by:

f* Main components ¢ Sub components

Select componet:
| |
Running hours taday:

Add..
Components already in the list;
Companent R.haours today Last madified

220 4000 12.06.2015
413 120682015

Ipdate.. | Delete..

Cloze window |

Note that in the figure above, two main componéiatge been added to the running hour list.
Main component 413 and 220. All jobs, includinggdbat are added to sub components of
413 and 220, for example sub component 413.01 20d 2, will all have the option to select
running hours when you add a job for the compon&ihsub components will use the main
components running hours (as in the example ahaove¥s you add sub components with its
own running hours into the list. In that case thle somponents will use the running hours of
the nearest owning component in the running hatr li



Add job

General Spare consumpkion

Job bype: | K.aon j
Control/M aintenance

Job name; |EIiI change

Description: Check and change all if needed.

E xpire type: (" Date f* Funning hours

R hours interyal |2|:":":|

Expired [R.Hours); |4|:|Ud

Department; | b

LILLL

kM achine

Cancel Add

X

In the figure above, a job is added to the 220drpmonent. As you can see above, you can
select to either use running hours or date forjtibsbecause the running hour have been
added to the running hour main list for the compdnieat this job is attached to.

In addition there is a tab for spare consumptioith\this tab you can set up which spare parts
to be consumed when signing out a job. The dethit®w to use this feature is covered in the
spare parts section further down in the documenntati

The job types and departments can be changed frermain menu Edit->Options.

Adding and signing out jobs (create history)

Under the main window, you can add, delete, emjty sut jobs and postpone jobs. In the

window below you can see how it looks when ediarjgb:




Edit job

X

General Spare consumpkion

Job bype: | K.aon j
Control/M aintenance

Job name; |EIiI change

Description:

Check and change all if needed.

E xpire type: Drate only [running kours not enabled)

Irterval [date]: |'| “ears ﬂ
Expired (date}  |16.02.2017 o
Department; | b j

kM achine
— ............................ E |:||t ...........................

As you will notice from the figure above, for thige of job it is not possible to select
anything for the R hour’s interval (running houterval) and Expired (Running hours). To be
able to create jobs that use running hours, yoe t@aadd the main component (or sub

component) that this job is related to, in the ragrhour list (see the running hour list section
above).

,j Fiunning hour mainlizt

The “certificate info” button in the edit job windoabove is only available when you create
jobs for the 112 Certificate and its sub component.



Compaonents

= 112 Certificate -
b 1121 Renewal Clazs HullMackingm
##4 11210 Intemational Load Line Certificate
b 11211 15M Safety Management Certificate
b4 11212 Intemational il Pollution Prevention Certificate
b 11213 International Tonage Certificate
bl 1122 Arrwaal Survey
bl 112,20 DNY Antifouling Sypstemn
b4 1123 Radio Certificate
##4 1124 Classification Certificate
# 112.5 Bermmaningzsertifik.at
bt 112,56 syl top. ditrait
/190 Consumnables
/331 Rotating cranes with crane pillars

;403 Steering gear, plants and columng, telemotor systemns
;404 Side thusters b

F] - [F] - [F] - [F

When you press the sign out button under the jsbslthe main window,
| Sign out job

a window will pop up where you can insert expiréedarunning hours, information about
who signed out the job for (automatically filledtatuspecified initials for logged in user) and
description of what was done:



Sign out job

Job info:

Compaonent . 602

Job name:  Change air filker

Ewxpired at:  18.08.2013

Interval: B Mnds

Consume parts: Mo zpare parts will be consumed .

Hiztary item:

D ate performed: |1 B.02.2016 J

Perfarmed by: |,.f_-.,|e:.;

Description: Changed the air filker.

Cancel | k.

There are some validation when completing jobsssuige no errors are made when
completing jobs such as: Not possible to complabs further back then one job interval from
expire date. And will not complete jobs that am®ithe future (more then today's date).
Postpone job in cases where not possible to compleexpired date or running hours.

In addition it is possible to override spare p#nt will be consumed. In the window that pop
up when clicking the .. button next to consume epayou can select which spare parts that
will be consumed, override number of items to comsuand add more spare parts that will be
consumed. See spare part section for more infoomati

When job is completed (signed out) you will createistory item under the history tab on
component for the job that you just signed out.

If the job expired many intervals ago and the wiseto complete a job many intervals later, a
new window will show up that let the user easilyngdete multiple expired intervals at the
same time, to close up the interval gaps. The wintih@t pops up are shown in the window
below:



Multiple job interval complete

Date period: 18.08.2013 - 09.06_2015. Interval: 6 Mnds

There are multiple intervals not zsigned out since last time job was completed. Sign out individual jobs by checking the
checkmark on the propozed interval. If jobs were completed on other dates then the ones in the list, pleaze sign out
each individual job manually from the zign out window, for each completed date interveal, starting with the firzt interval
after the current expire date.

|z done  Completed at Completed by YWhat waz done

[ 18.08.2013 Alex

[v 18.02.2014 Alew Changed air filter. All OF.
[ 18.05.2014 Alew

| 18.02.2015 Alex

03.06 2015 Alex Changed the air filker.

Edit.. Cancel Complete

In the window you can see that the expire dateM8a38.2013 and the job is being completed
on 09.06.2015, job interval is 6 months. So betwbese dates there were 4 intervals that
have expired and one that is being completed befgree date (the last item). If the same
thing need to be completed on each interval, tkeestthing to do in those cases, is to first
double click on the first interval (18.08.2013)emit. Then write who completed the job (if
other then the default) and what was done. Copy $GT) the description of what was done,
and double click the next one (or click the editttmi), then paste (Ctrl + V) in the what was
done data. The items that have a checkmark neketa will be completed (signed out).

To see the history items that was created when [img these two jobs, see the jobs
analysis section below.

Copy job:

To copy a job, right click on a job in the job list



i) Specifications | =) Jobs | =) Spare parts ) Hiskory
Job type | Job name

Cont Exchange lub ail and filkers

Cont Colingwater analysiz

I:]‘IEII"IEIEE Dirire=r T 7 Cilbarn
Cont Change | Copy job..
Cont Change Zinc Anode
Cont Check mounting boltz for Tightnes
Cont Change the Marine Gear Oil

This will bring up the job window:

X

Copy, job

General Spare consumpkion

Job type: | k.on j
Control /M aintenance

Jaob narme: |New joh

Description:

Expire ype: (™ Date f* Running hours

F kours interval: |1 000

Expired [F.Hours), 30983

Department; | ]

=
-
=
Deck
Cancel &dd

The information that is copied on the jobs is: dgi®, interval, expire date or running hours
and department. The expire date is based on tmengihour or expire date from the previous
job. To change the expire date or running houtsetbased on the current date + interval,
change the interval date or running hour intervaht will update the expire info based on the
current date.




Job status:

I_]) specifications | =) Jobs - () Spare parts

Jobtype  Job name

Cort
Cort
Cont
Cont
Cont

Exchange lub il and filkers
Colingwater analyziz
Change Frimary F.O Filters
Change air filker

Change Zinc Anode

Q Hiskary
Statuz | Ewpire date | [or] expire r. hours | B hours interval
y - 23789 500
W 1goezolz o - -
& - 24289 1000
W 1808203
L
-

Cont

Check mounting balks for Tightnes
Change the Marine Gear Qil

@

On the jobs list, the status column show the staftdise jobs. The colours in the status

column mean: Red - expired job, orange - job wippiee within the next 30 days, green mean
that it is more then 30 days until the job will e@&p

Job analysis

Under the jobs tab (mentioned above) there isalsotton for job analysis. The window that
pop up when you click on the button, is shown below

Job analysis

Change air filter

what was done Completed by
Changed the air filker. Alex

Changed ai filker. All OF.

Additional infor:

What was done;
Changed air filker, All QF.

Days overdue [before completed):
184 [about & maonth overdue)

Expire date Date completed Expire B.H. R.H. completed
18.08.2014 09.06.2015
18 013 8.022

Close




With the job analyse option, you get an overvievthef history on the job, and also how many
days or running hours each job was overdue (ettbipleted before due or after due date /
running hours).

The option is available from the main window, unther jobs tab, or from the search result
window.

The "show system log items" checkbox is for filbgriout log events. By default the system

log events (such as change of interval etc) idsglayed. To display the system logs items,
check the checkbox.

Adding specification

To add a specification to a main component, orcaubponent, press the specification button
under the main window. See window below:

Mew spesfication for component

Serie Mr: ||

hake: |

Mizc info:

[ Crtical [for zafety on board)

Carel 0k,

Spare parts

You can add spare parts from the spare parts téheomain window, by first selecting the
component and then adding spare parts on the campon



You can set up that spare parts can be consumen yalesign out a job. When consuming a
spare part, the units and units prices will beest@o you can get the information out in a
report or on the spare part more info window.

To set up consumption of spare parts:

1. Add a spare part to a component.

X

Add spare part

Fart name: |F.EI. filker

b ake: |M&E

Serial rr KL 9385758

Supplier: | Brureoll Matarfabrikk A5 j J
Department; | D ﬂ J
Categary: | il filter | J
I it price: |5|3J:||:| kr

Mizc. infao: |

[ Crtical [for zafety on board)]

Cancel Add..

NOTE: Currency is based on the settings in yourmasr. In the case above the settings is for
Norwegian krone.

2. The added spare part can now be attached tofarjauto consumption when signing out a
job:



Edit job X

General Spare consumpkion

Sparesz that will automatically be consumed when signing out thiz job.

Spare name Uitz

Add zpare.. | Edit zpare.. Delete spare..

Cancel ............................ E |:||t ...........................

In the window above 1 spare have been set up toheumed automatically. You can also
change the number of units to consume. Lets saywuld like 2 filters to be consumed
when you sign out the change filter job. To do thadt click edit spare, and change the

number to 2.

3. When signing out a job, you can override theadkfauto consume settings that where
defined on the job (defined in the previous stepg)clicking the .. button on the sign out

window below:



Sign out job

Job info:

Component nr: B5Z2.04
Job name:  Change F.0 filkers

Ewxpired at: 30933

Inter«al 1000
Consurne parts: 1 spare part will be consumed J
Hiztary item:
D ate performed: |1 B.02.2016 J

F. H performed: |4EIEIEIEI

Perfarmed by: |

Dreszcription:

Cancel k.

The following window will pop up when you click thmitton:



X)

Owerride spare part consumption

Spare parts to consume when this job 1z signed out.

Tatal price: kr 55,00

[Inits to conzume | Price

Conzsume  Spare part name

F.0. filter

Add zpare.. Edit zpare.. Dane

In this window you also get an overview of the praf the spares that will be consumed. You
can add and remove other spares as you need them.

4. An overview of the price and number of sparétirat have been consumed over time,
can be found in the spare part more info window:



Spare part more information

General  Spares consumption logg

Date Jobname Conzumed Frice

16.02. 20016  Change F.O filkers

Claze window

The information is also available in a spares coreireport (see report section for more
info). The mentioned report is grouped by datey@moget an overview of what the price was
for spares consumed on a particular day. Thedilieat you can choose from in the report
include date from - to, supplier, category and depant.

Add and update supplier list

In addition to adding a supplier from the add spmaes window, you can also add a suppliers
from the menu Edit->Add supplier. The window thapp up is as below:



Add supplier

Supplier narme: ||

Address: |

Telephone: | Faw:

E-rail: |

Other info:; |

&dd

Exizting suppliers:

Supplier name Address Telephone E-tail

Frank Mohn A5 M esttun
Fururo Morge A5 Alesund, Mo... 70102950 B
Scandinavian Micro Sys.
Spery

Raobertzon

|3

£

are info.. | Edit.. | Delete..

Cloze window |

Sear ch for expired jobs

To search for expired jobs, press the find buttothe main window and select the Expired
jobs option in the dropdown menu. The window th@igpup lets you search for expired jobs
by either today's date or specifying expired jobs.



Search for expired jobs

Expire job info:

{* Jobs expired now " Specified expired jobz

| _|

Filter [optional];

Job bype:

Ll Lo

Department:

b ain compaonent from:

b ain companent ta:

Close Search

The jobs expired now option, search for date amding hour jobs that have already expired.
The specified expired jobs option let you searatjdbs that have expired or will expire in the
future.

With the filter, you can filter out the type of argd jobs that you would like to be displayed.

When the search is completed, you will get a seastlt window, where you can sign out,
postpone, do job analysis and get more job infalmat



Searchresults

Ewpired jobs:
Comp. nr. Type | Job name Dep. | Date expired | RB.H. Expired
G501 Fon  Exchange lub Oil and filkers b 30433
G002 Fon  Check mounting boltz for Tightnes b 18.08.2M3 ]
G002 Fon  Change £inc Anode b 18.08.2M3 ]
B02.09 Fon  Check Turbocharger b 18.02.2014 ]
(1 Fon  Adust Eng. Walve Lash Clearance b 1]

Colingwater analysis : I

Mare job infa.. Job analpsis.. Postpone job.. Sign out job..

Cloze windows

Unplanned events

An unplanned or unscheduled event, is an evenbwitbxpire information and that happen
only once. For example, a replace of one enginle avitew engine. The unplanned event
functionality is used for recording the event, antl show up in the history only. When event
occurs that affect jobs on the component (sucleplace engine example), it would be
necessary to update all affected jobs (with zemgdunning hours and new expire dates) and
also update running hour main list.



x]

Unscheduled event [service report)

General info:

A service report are an unplanned event that accurzs, such
az change aof the entire engine. Enter anly zervice repart
when no zcheduled job exizt that can be zsigned out for the
event. The service report will show up in the higtar only,
not under jobs.

Jobinfio;

Component o 417

Jobb name: Unscheduled event [zervice repart]

Service report item:

D ate performed: |I:I5_EI.'-".2EI1 2 J
Performed by: |
Dezcnption:
Cancel ak

To access the functionality either click on the maienu Edit->New unscheduled event
option or right click on the component in the comeut list and select add unscheduled event
menu item.

Postponejob

The postpone window is for changing the expire wiffthe job, in cases where the job could
not be completed in the planned expire date / nmhoburs. When postponing a job, it is
necessary to specify new expire info and a reasopdstponing the job, so that it is possible
to track the change in the history of the componéné postpone button is available from the
jobs tab in the main window:

@ Pozstpone job

When you press the button, the following windowl wop up:



Postpone job E|

Poztpone thiz job until a later ime, e.g.due to unforseen events.
Spesify new expire date or running hours and reazaon far this

postpaning.
Mew date expire: [Current date expire]:
|25.11.2EI1'I J 20.11.20M

Reazon for postponing:

Hawe to wait for new spare part, before we can complete
the job.

Cancel k.

When postponing the job. The job expire date wilirege to the new expire date / running
hours. In addition a new entry will be made in ltihgtory of the job so it is possible to see at a
later time why it was postponed.

General search:

The general search window is available from thd batton in the main window.

. Find
Task lisk. .
@ Expired jobs.,
General search., |

When you click on the menu item, a new window ywdb up:



X]

General search

Search far:
{* Components " Jobs " Spesifications (" Spare parts " Suppliers " Histary
Criteria:
Search for: 581 Contains ﬂ
Search
Matches:
Campanent no Component name
S anitary suppl
5E1.02 Hot water Heater
581.03 Hydrophare Tatk

Gato

Cloze window |

In this window, you can search for components, jepscifications, spare parts, suppliers and
history.

In the jobs tab you can for instance search foinathe Machine (M) department, by selecting
the Equals query option in the dropdown above #aech button and then entering M in the
search for criteria.

With the "goto" button. You can goto the componspgre part etc in the main window.

Task list:

You will find the "Task list" from the find buttom the main window.

. Find
| Task list,,
@9 Expired jobs.. :
General search,.




The task list is for getting an overview of thegdbat have expired, will expire in the next 30
days, will expire in 31-60 days or have been coregl¢he previous 30 days. Note that the
lists are sorted by component number to bettertfiednformation that you are looking for.

\ Expired ! Due niecek 30 days Due next 31-60 days o Completed |ast 30 days

Component no Tepe  Job name Department  Expire date

Cloze window

~Summary:
.‘ Total expired: 14 Total due next 31 - B0 days:
Total due nest 30 daps: 1 ) Completed last 30 days
Filker:~
M ain component from; Department; | L]
M ain component ta: Job type: | L]

Expire 1. hours

Clean Level glass 3
E0Z Fon  Check mounting bolts for Tightnes bd 18.08.2M3
E02 Fon  Change Zinc Anode ] 18.082mM3
E0Z Kon  Change air filter I 18082013
E0Z2 Kon  Change the Marine Gear Oil bd 18.022M4
B0Z2.09 Kon  Check Turbocharger b 18.02204 -
ERZ Fon  Inzpect the ‘wirng b4 - 304283
E52 Fon  Check maunting Boltz for Tightness 4 30483
ERZ Fon  Check Hozes and Clamps for Condition and I 30483
E52 Kon  Check Belt ] 30983
CR7 ¥ oman Tl mnmm =ie Filbmr kd 2Na00
STV S A s aodiens

Filter..

Note also that the Total expired, total due nexti@@s, total due next 31-60 days and
completed last 30 days are default based on alijpkhe system. Those values will be
updated based on the filter that you put into therfpart of the task list window.

On the different lists there are also various meauaslable (different menu on the completed

list):

o) Expired Due next 30 days Due next 31-60 days ) Completed |ast 30 dayvs
Comporent no  Tupe  Job name Departrient  Expire date
581.03 Kan  Clean Level glass ] 18.05.2013
B02 Kaon  Check mounting bolts far Tightnes t 18.08.2013

Change Zinc Anode & 2.08.2013
E02 Kon  Change air filter b 18.08.2013
E02 Kon  Change the Marine Gear Oil b 18.02.2014
E02.09 Kon  Check Tubocharger I 18.02.2014
E52 Kon  Inspect the Wiring I -
E5Z2 Kon  Check maunting Bolts for Tightness 5]
E52 Kaon  Check Hoses and Clamps for Condition and ]
E52 Kan  Check Bel il
CED e Mle minmm =ir Filbmr (¥}

Expire r. hours

30433
30433
30433
30933

QAn0o0a

More job info..,
Sign out job. .
Postpone job..

Job analyze. .

On those menu items you can get more job info, sigrob, postpone jobs or analyze the job

in more details etc.



Create backup

E%: Maintenance Master - v4.5

File | show Edit  Ahout
Create backup. .. Ckrl+6
Restore backup from file...  Crl+R

& genddata Chrl-

Exit Chrl+x

To create a backup, select File->Create backup.nvttreebackup is done you can use this
backup on the multi user (office) version to impitwt boats data, or keep the backup so that
you can restore the database to the state ofrtteedf backup.

To restore a backup select File->Restore backup file. Or click at the backup button at the
bottom right corner of the main window.

It is recommended that you create backups on daebasis, and keep a good routine of
creating backups. Create a new backup at leastaonezk.

Auto backup:

A backup is automatically created each time thgm starts. If the program is unable to
run for any reason, an attempt will be made tooresihe database to the state which it was in
before the database because corrupted (last stiddesskup made).

Auto update:

Each time the program start, it will default chéokupdates. If a new version of the program
is found, the window below will pop up. If you ansmyes. The needed files will be
downloaded and the update will be executed. Progvalmestart as needed to apply the
changes.

Information

\ll‘) & new version of the program was found. Do you wank ko update to this version now?

Yes Mo

If you do not want the program to automaticallyadhér updates on start-up. You can
disable auto update from the main menu option E@iptions:



£ Maintenance Master - ¥5.1

File Show | Edit | About

Mew main component ChElH-M
] Re l
Ij Mew sub component Chrl+3
Mew unscheduled event
s
& Mew suppliers Chries |
oy 112 = Mew element in mainlisk For running hours Cerl+H
+- ol BE
+- b BO2 Opkions. . d
+-- o BBZ )

| User admin and rights.

When you select the option, the following windowlywbp up:

x]

Options

General settings Job bypes Departments Spare categories

[v Enable auto update

Cloze window

On the general tab in the options window. If yosadhle automatic update at start up from the
option, you can check for updates manually at ang from the About-> Check for updates
menu item:

Eile Show Edit | About |

Homepage
3 Reports Purchaze [
Email author
| & PDF manual
by 112 Certificat View video tutorial
b 581 Sanitary
&b, B02 Main En Check for updates..
H-p. 652 AusEng The program




The menu item will give you a user friendly wizdod program updates. The wizard will
guide you through the update process, includingrdoad of the files, get an overview of
what's new in the program etc.

Other options

In the options window (Edit->Options on the mainnmg you can define your own
departments (used in the job window and sparevgadow), job types (used in job window)
and spare categories (used in spare part window).

Reports

Show reporis

LCertificates

Completed jobs [histany]
Component List
Joborders [expire zearch)
Running haour mainlist
Spare parts cost

Spare parts overdigw
Supplier list

Cloze window S o,

There are currently 8 reports available in the paog The reports are:

- Certificates: The 112 component is a special aomept in this system. It is reserved for
certificates, and with this report you will get averview of all certificate components.

- Completed jobs (history): Get a list of jobs cdeted in a set interval (from date - to date)

or based on today's date and running hours expiteglreport is grouped by component and
job.

- Component list: Get an overview of all main com@ots and sub components in the system.

- Job orders: Get an overview of jobs that haveregpor will expire within the date or
running hour that you specify as search criteri@mjou run the report.

- Running hour main list: Get an overview of comgots that have been added to the running
hour main list, with the running hour today listeekt to the component.



- Spare parts cost: The spare parts cost repud,ygiu an overview of the consumed spare
parts. The report is grouped by date, and can sebtatal of the days cost. Filters in the

report include date from - to, supplier, departraend category. See spare parts section above
for more info about this report.

- Spare parts overview: Spare parts overview. €pert is grouped by component name.
- Supplier list: Here you get an overview of thengg address, fax and phone number and

email to all the suppliers added to the system.

On some of the reports, there are filters wherecgureduce the results in the report by
entering values in the filter dialog box that poyps before the report is displayed:

Completed jobs filter, E|

Main component From: ||

Main component bo: |

Expire From: |14.1IZI.2I]14 j
Expire to: 11.06.2015 |
Cancel | (0] 4 |

In the report window you will have several optidas/ziew the report:

First icon on the icon group above, is for printthg report. The second for saving the file
(currently can save the file as PDF), third icofoisexport to PDF. On the PDF export dialog
box, you do not need to change any of the defaatibos, just click export to create the file.
The last icon is for searching the document.

For search, you enter the text in the window amdifd. To find next match in the document
press F3 to find the next occurrence.

& 100% - @ 5

On the next group of buttons you can zoom in artdlowaddition to make the page full
screen mode. To exit full screen mode, right ctiokthe report and select the "Full screen™
option.



(= Print
E Save r

Lo Export to POF

4 Find

J!'% Zoam In
:% Zoam Cuk
El Full Screen

On the next group of buttons below
20 &

The first button in the group is for group outlitiee second button is for showing thumbnails
on the left hand side of the report, as below:

SE AR R owome- QE | EME| W 4 ofg b M Close

Completed

Completed by Description

Click on the button again to remove the thumbnadsy. The last button in the group above
is for printer options.

The final group of buttons in figure below
M 41 of 9 b M

are for navigating the pages in the report.

User admin and rights

The user management functionality lets you defsersiand their rights in the system. This
way, it is possible to have different users wité tlght to perform different actions in the
system.

When defining initials for a user. Those initialslwe used everywhere, to track who have
performed the actions in the system.

When first installing the program. There is onlyearser, the admin user. This user, have the
right to perform all actions in the program. Thepaord is initially, also, not set for this user,



so that when you start the program, no login scigeisplayed. If you want the program to
display the login screen, so that the admin hayedwide password, just set the password
from the user admin settings window by editingdker from the list (see screen below):

User. admin settings PX|
E xisting uzers admir;
|lzer name Feal name | nitialz Pazzwiord et
Adrmin Admiristrator Admin Mo
Mew user.. | Edit uzer. | Delete user..
Cancel | k., |

You can also set the initials for the admin uset @sker screen. Otherwise it is not possible to
change anything else for the admin user, becaisedbr is a special user in the system, and
need to have all the user rights.

You can create additional users that might havagiits or limited amount of rights to
perform different actions in the system (see owemof rights below). In the figure below is
an example of a new user created in the system:



User admin

| zer options:

R eal name: [ritials;
|F'eter Anderzon P.a.

| zermanme:

|peter

Pazzwiord:

RERNERERRER

Fepeat password:

EEREPREERETY

IJzer rights:

|Jzer have access to -

Add, edit and delete component

Add unzcheduled event

Edit zpecification

Add, edit and delete job

Sign out job

Foztpone job w

Select all | Deszelect aII|

Cancel | k. |

X

You can currently set the following rights:

- Add, edit, delete components

- Add unscheduled events

- Edit specifications

- Add, edit and delete jobs

- Sign out jobs

- Postpone jobs

- Add, edit and delete spare parts
- Create backup

- Restore backup

- Send data to server

- Add, edit and delete suppliers

- Change user rights

- Add, edit and delete running hours




L ogging events

Some events are logged in the system. The evesitgleawhen jobs are deleted, job name
change, when running hour main list change, whescheduled events occur and when job
interval or expire info change. The events loggaul lse found under the history tab or job
analyses window under the job tab (see job anadgziBon for more information).

Deleted jobs are marked with stroked out text, olibgged events are marked with grey text
in the list (see figure below for some history okacomponent).

I specifications =) Jobs =) Spare parts | =) Hiskary

Wwihat waz done Caompleted by Date completed  |R.H. completed  Jobtype | Job name

Job name changed from 'Batteri 4.5, 2202203 - B attem services
Changad the batban. A5 2202003 - kaon Battan cardcas
Checkup completed. A5 2202213 - Bes Elmnotar checkup

Send datato office (server)

With the send data functionality, you can senddda from the boat version to an office
version that can keep track of the data from athefvessels. The office version, also have
built in functionality to send out notifications wh data is about to expire (it is possible to set
the interval) or have already expired. This wayy yoll never have to forget to do
maintenance on the specified date.

After you press the send data button, the windowbevill appear:

Status §|

Status:

Please wait.. Tving to connect to server.,
Connection OF,

Creating package please wai.

Package done.

Resulting file is: 28 kb

Tryving to send file to server, please wait..
[ata gent to server was OK,




It will let you know if the data was sent OK, hovglthe resulting file was and if there were
any issues sending it to the server.

This is how the office version looks like whendtwaiting to get connections from the
vessels.
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Options [double click to select]:

Yessels added:

%" Michelle
MY Julie
k% Ernma
% D emo

|

]

By
By
By

F

Update log;

Waiting far connections, .

Hide server




